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Q.1 Select the figure that can replace the question mark (?) in the following series.

# # #] @
@ ?
@ @
Ans
X1
@
x 2 @
#
X @
#
o 4
@ #

Question ID : 7773935351
Status : Answered
Chosen Option : 4
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Q.2 Select the figure that is related to the third figure in the same way as the second figure is related to the first
figure.

) : || (O 7

Ans
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=

Question ID : 7773935360
Status : Answered
Chosen Option : 4

Q.3 In acertain code language, ABDUCT is written as 1TAC5BS. How will DEARTH be written in
the same code language?

Ans X 1.C21QSI
& 2.C21QSG
7 3.CD1QSG
X 4.E21QSG

Question ID : 7773935352
Status : Answered
Chosen Option : 2

Q.4 A group of letters is given which are numbered 1 to 8. Four options given below depict combinations of
these numbers. Select that combination of numbers so that letters arranged accordingly form a meaningful
word.

R E S o} T A D I
1 2 3 4 5 6 7 8

Ans X 1.6,3,52,4,1,8,7
% 2.3,526,47,8,1
72 3.3,526,4,1,8,7
o 4.6,3,52,1,4,8,7

Question ID : 7773935344
Status : Answered
Chosen Option : 4
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Q.5 Three of the following four word-pairs are alike in a certain way and one is different. Select
the odd one.

Ans X 1. Wall- Brick
" 2. Milk - Butter
< 3. Rubber- Latex
25 4. Prism- Glass

Question ID : 7773935342
Status : Marked For Review
Chosen Option : 2

Q.6 Select the term that will replace the question mark (?) in the following series.
30,34,17,21,10.5,?
Ans X 1.17
o 2.145
X 3.14
X 4.15

Question ID : 7773935347
Status : Marked For Review
Chosen Option : 2

Q.7 Gayatri is four times as old as Arya. Five years ago, she was five times as old as Arya. How
old is Gayatri now?

Ans X 1.10years
25 2.20 years
" 3. 80 years
X 4. 40 years

Question ID : 7773935357
Status : Answered
Chosen Option : 3

Q.8 WG, K, L, M,N,O,P,R3RY &l ‘X’ 3R ‘'Z' 710 &l Rl & Reeht @ fAwen HY amm =t 21
&t Y sgawn FAEfaf@e et & sgar g+ g

(a) Toh R # SifAehaw ™ SR Griad IR Afth 96 Johd &1

(b) 'G' 3R 'M' Ueh &) &R ¥ Ueh T AT &A1 1'Y' 39 hR | 11 21

(c) 'K' 3R 'L, 'R' & TI1A Qeh &Y R A g1 gl Gahd &1

(d) '0"'P' & AT ATAT AT TR FehdlT cAfeh=1 'G' 3R 'N' & T UTAT & TehelT 21
gl R'Z *R & arn wear g, df AEfaf@a d @ s araa @2

Ans X 1.08RY 'Z &R # Teh 9T T & 8
2. Y 3RK 'Z &R # Teh 919 IHT & 8

X 3. M 3R N X' R Ueh 1Y I it &
o 4.0 3R R 'Z' &R ¥ Teh TqTY IHAT & &

Question ID : 7773935358
Status : Answered
Chosen Option: 4
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Q.9 Select the term that will replace the question mark (?) in the following series.
SEM, NLD, ISU, 2, YGC
Ans X 1.DYL
X 2.BYL
o 3.DZL
X 4.CYL

Question ID : 7773935343
Status : Answered
Chosen Option: 3

Q.10 In a certain code language, ‘INLET' is written as ‘ZKRTO'. What is the code for ‘TOUCH’ in
that code language?

Ans X 1.NJAUZ

X 2.NJATZ
«” 3. NIAUZ
X 4.NJBUZ
Question ID : 7773935353
Status : Answered
Chosen Option: 3
Q.11 Three Statements are given followed by four conclusions numbered |, I, lll and IV.

Assuming the statements to be true, even if they seem to be at variance with commonly
known facts, decide which of the conclusions logically follow(s) from the statements.

Statements:

1.All oranges are pears.

2. Some oranges are mangoes.
3. All mangoes are fruits.

Conclusions:

|. Some pears are mangoes.
1. Some fruits are pears.

11l. No fruit is an orange.

IV. All pears are fruits.

Ans X 1.0nly conclusion | and IV follow
" 2. Only conclusion | and Il follow
25 3. Only conclusion |, Il and Il follow

25 4. Only conclusion Il lll and 1V follow

Question ID : 7773935354
Status : Answered
Chosen Option : 2

39 Teachingninja.in



Q.12 The two expressions on either side of the sign (=) will have the same value if two terms on
either side or on the same side are interchanged. Find the correct terms to be interchanged.

7-4+2+5%x3=8x3+10+5-6
Ans  # 1.6,7

X 2.4,10

< 3.4,8

X 4.7,8

Question ID : 7773935350

Chosen Option : 1

Status : Answered

Q.13 Select the pair of words from the given options that shares a similar relationship as:
Speak : Shout
Ans X 1.Refuse: Accept
#< 2. Eat: Drink
25 3. Talk : Whisper
o 4. Walk: Run

Question ID : 7773935341

Chosen Option: 4

Status : Answered

Q.14 Select the option that is related to the fifth number in the same way as the second number
is related to the first term and fourth number is related to third number:

19:23::11:13::29:?
Ans X 1.37
o 2.31
X 3.33
X 4.35

Question ID : 7773935345

Chosen Option: 4

Status : Answered
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Q.15 Choose the Venn diagram from the given options which represents the correct relationship
amongst the following classes:

Women, Teachers, Singers
Ans

Chosen Option: 4

Question ID : 7773935356
Status : Answered

Q.16 From the given options, select the number pair which is different from the other three
options.

Ans X 1.81-121
X 2.64-16
X 3.36-25
o 4.49-80

Chosen Option : 4

Question ID : 7773935346
Status : Answered
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Q.17 Select the term that will replace the question mark (?) in the following series.

1,3,9,23,2,115
Ans X 1.54

X 2.50
X 3.51
& 4.53

Question ID : 7773935348
Status : Answered
Chosen Option : 4

Q18 Which of the answer figures is the exact water image of the given figure?

Ans

Question ID : 7773935359
Status : Answered
Chosen Option: 1
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Q.19 Which of the following two signs need to be interchanged to make the given equation
correct?

96+48-24+2x50=4
Ans X 1.+andx

X2 +and—
¥ 3.xand +
X4 +and~+

Question ID : 7773935349
Status : Answered
Chosen Option : 3

Q.20 Qah YU & d1E &1 YRUTE | 3R 11 1 ey R faar fifSie ok aa RS o & aromeit & @
& It hy= A siafifga &1

HYT:

=T & MSP # gfg o1 foram= Rty & @ &, e siwon g §f § IR A R 81
YRUMG:

1. 7 & MSP # f3hg 71Q sreemal & foham ger gl 1

Il. SRR 7 fFari &t ey fan & fr @ em ARty @ g== & forg MSP # aites &R faamRr
Coaf

Ans X 1.13fR 1l 4T gromd Siaffga §
o 2. hadl uRoT | idfRd &
X 3.9at gron | SR 7 & aron || siafifgd &
X 4. Fae 4RO || Siafiiga @

Question ID : 7773935355
Status : Answered
Chosen Option : 2

Section : Quantitative Aptitude

Q.1 The difference between two positive numbers is 2701. When the larger number is divided by
the smaller, the quotient is 7 and the remainder is 163. If the larger number is divided by
361, the remainder will be

Ans X 1.211
X 2.223
X 3.242
o 4.236

Question ID : 7773935367
Status : Answered
Chosen Option : 4
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Q.2 A trader buys 20 washing machines for a total of Rs. 3.8 lakhs, of which 8 machines are of
type B and the other are of type A. The selling price of a washing machine of type A is 2.5
times that of type B. If he earns a profit of 20% on the whole, then what is the selling price
of a washing machine of type A?

Ans X 1.Rs.30,500
& 2. Rs. 30,000
< 3.Rs. 32,000
X 4.Rs. 27,500

Question ID : 7773935376
Status : Answered
Chosen Option : 2

@3 afx /52— 6v78 =21+ 12v3 = x + Y3, & (x+3y) & AT =T ¥?
Ans X 1.6

% 2.30

X 3.19

& 4.8

Question ID : 7773935365
Status : Marked For Review
Chosen Option: 4

Q.4 A certain sum is divided between A, B and C in the ratiog :g

Aand C is Bs. 1872, then the sum (in Rs.) is:
Ans X 1.7344

: Z. If the difference between the shares of

& 2.7248
< 3.6788
X 4.7200

Question ID : 7773935371
Status : Answered
Chosen Option : 2

The value of 9= + 11> ofi—(lix11+ 11—5)+5+5.-::U1"'2E is:
9 a3 ] 20 9 19 9 3 a8 9

Ans
x 1.
TH

Question ID : 7773935363
Status : Answered
Chosen Option: 4
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Q.6 afE 300 T x% 200 & (x+5)% & 15 & 31fde &, at (250+x) T 20%, 150 & (x+15)% @ fFe=m
ufaerg w87

s X1 ?s%

x2 9lo
11

3 819
3

x4 829,
11

Question ID : 7773935368
Status : Marked For Review
Chosen Option: 1

Q.7 Pipes A, B and C together can fill a tank in 18 hours. All the three pipes were opened
together for 10 hours and then only pipe C is closed, and A and B together took 12 hours to
fill the remaining part of the tank. Pipe C alone can fill the whole tank in:

Ans X 1.45hours
< 2.36 hours
«# 3. 54 hours
25 4.40 hours

Question ID : 7773935380
Status : Answered
Chosen Option: 3

Q.8 The value of (55 +400f3) X2 —[36+5 0f{4 x8—(17—23) = (15 =2 0f 5)}] is:
Ans
x1. 22
30
4

X2
10

Question ID : 7773935366
Status : Answered
Chosen Option: 3
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Q% The value of [(54)% + (4.5)%] = [(5.4)% — (4.5)%] — (0.93 = 0.84) is:
Ans X 1.256
X 2.252

X 3.29
 4.26.8

Question ID : 7773935364

Chosen Option : 4

Status : Answered

Q.10 Six years ago, the average age of A, B and C is 28 years. After 6 years from now, the
average age of A and C will be 39 years. What is the age (in years) of B, after 5 years from
now?

Ans X 1.42
X 2.40
o 3.41
X 4.43

Cho

Question ID : 7773935373

Status : Answered
sen Option: 3

Q.11 The population of a city increases by 10% every year. If the difference between its
population at the end of second year and the third year is 7293, then its population at the
end of first year was

Ans o 1.66300
X 2.58344
X 3.80223
X 4.51700

Question ID : 7773935369

Chosen Option: 1

Status : Answered

Q.12 What is sum of the digits of the greatest number of 4-digits which when divided by 20, 28,
32, and 35, the remainder in each case is 17?

Ans o 1.31
* 2.35
X 3.23
X 4.4

Chosen Option: 1

Question ID : 7773935362
Status : Answered
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Q.13 A man sells an article by giving 20% discount on its marked price and still earns a profit of
25%. If the cost price of the article increases by 10%, how much discount percent should he
give now on its same marked price so as to earn same profit percentage as before?

Ans X 1.12.5%
& 2.12%
< 3.10.5%
X 4.10%

Question ID : 7773935377
Status : Answered
Chosen Option : 2

Q.14 In a school, the number of girls is 20% less than that of boys. 45% of the girls and 84% of
the boys take part in a social camp. The number of girls in the school is what percent more
than the total number of students who do not take part in the social camp?

Ans 2

X1 66;%

2 33?%

3. 30%
X 4 20%

Question ID : 7773935370
Status : Answered
Chosen Option : 2

Q.15 The ratio of the incomes of A and B is 6:7. A and B save Rs. 12000 and Rs. 9000,
respectively. If the ratio of their expenditures is 4 : 5, then their total expenditure (in Rs.) is:

Ans 1.135000
% 2.156000
< 3.147000
X 4.144000

Question ID : 7773935372
Status : Answered
Chosen Option : 1

Q.16 4 sum of Rs. 7800 amounts fo Rs. 11752 in Si vears at a certain rate percent per annum. What will be the
simple interest on the same sum in 7% vears at four-fifth of the same rate?
Ans o 1.Rs. 4446
#< 2.Rs. 4388
/5 3.Rs. 4584
5 4.Rs. 4464

Question ID : 7773935374
Status : Answered
Chosen Option: 1
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Q.17 The areas of three adjacent faces of a solid metallic cuboidal box are 108cm, 144em and 192cm. It is

melted and recast into 27 solid cubes of the same size. What is the sum of the lateral surface areas (in cm2)
of 12 such cubes?

Ans X 1.1152
< 2.960
o 3.768
X 4.640

Question ID : 7773935378
Status : Answered
Chosen Option : 3

Q.18 what is the compound interest (in Rs.) on a sum of Rs. 15500 at 13 i% in 24l years, if the interest is
compounded 9-monthly? (Nearest to Rs.)

Ans X 1.5341
X 2.5242
& 3.5131
X 4.5238

Question ID : 7773935375
Status : Answered
Chosen Option: 3

Q.19 In a 40 litre solution of acid and water, the ratio of acid and water is 3 : 5. If 10 litres of the
solution is replaced by 15 litres of water, the percentage of acid in the resulting solution will
be:

Ans X 1.30%
X 2.20%
o 3.25%
X 4.28%

Question ID : 7773935379
Status : Answered
Chosen Option : 3

Q.20 When 6944, 7796 and 9287 are divided by the greatest number p, the remainder in each
case is g. What is the value of (3p-2q)?

Ans X 1.399
o 2.383
X0 3.259
X 4.193

Question ID : 7773935361
Status : Marked For Review
Chosen Option : 1

Section : English Language
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Q.1 Select the most appropriate word for the given group of words.

Certain to happen and unable to be avoided or prevented
Ans X 1.indefinite

«# 2.inevitable
#5 3. invincible
#< 4.indelible

Question ID : 7773935385
Status : Answered
Chosen Option : 2

Q.2 Identify the segment in the sentence which contains a grammatical error. If there is no error,
select No Error.

There is / many fascinating / puzzles in nature.
Ans X 1.puzzles in nature.
25 2. many fascinating
25 3. No Error
o 4. There is

Question ID : 7773935388
Status : Marked For Review
Chosen Option: 3

Q.3 Given below are four jumbled sentences select the option that gives their correct logical
sequence.

A. During that time she would forget all her work and listen with the greatest concentration.
B. Later, she could repeat the entire text by heart.
C. My grandmother never went to school so she could not read.

D. Every Wednesday, the magazine would come and | would read the next episode of the
story to her.

Ans X 1.CBDA
" 2.CDAB
X< 3.DCBA
< 4.BDCA

Question ID : 7773935382
Status : Answered
Chosen Option : 2
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Q.4 Select the most appropriate antonym of the given word.
CALM
Ans X 1.stable
& 2. evident
" 3. agitated
< 4. fixed

Question ID : 7773935389
Status : Answered
Chosen Option: 3

Q.5 Select the wrongly spelt word.
Ans X 1.servile

25 2. interruption
«# 3. abreviation

X 4. symmetry

Question ID : 7773935390
Status : Answered
Chosen Option: 3

Q.6 Select the correct passive voice form of the given sentence.

Professional advancement requires honesty and sincere work.
Ans  «# 1. Honesty and sincere work is required for professional advancement.

25 2. Honesty and sincere work has been required by professional advancement.
25 3. Professional advancement is required for honesty and sincere work.

< 4. Honesty and sincere work requires professional advancement.

Question ID : 7773935386
Status : Answered
Chosen Option: 1

Q.7 Select the most appropriate synonym of the given word.
CONCISE
Ans X 1.capable
«F 2. brief
25 3. minor
X 4. relevant

Question ID : 7773935383
Status : Answered
Chosen Option : 2
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Q.8 Select the most appropriate synonym of the given word.

ADROIT
Ans X 1.complete
/% 2. advanced
2 3. mature
o 4. skilful

Question ID : 7773935387
Status : Answered
Chosen Option : 4

Q.9 Select the sentence structure that is meaningful and grammatically correct.
Ans X 1.Essential items online most people started ordering during the pandemic.

«" 2. Most people started ordering essential items online during the pandemic.
75 3. Started ordering essential items online during the pandemic most people.

X 4. People most essential items during the pandemic started ordering online.

Question ID : 7773935381
Status : Answered
Chosen Option: 2

Q.10 Select the most appropriate antonym of the given word.

OBNOXIOUS
Ans 4 1. agreeable

25 2. undefined

25 3.vague
X 4. unclear

Question ID : 7773935384
Status : Answered
Chosen Option: 1

Section : General Awareness

Q.1 The first Livestock census in India was conducted during:
Ans X 1.2017-2018

< 2.1856-1857
/5 3.1901-1902
" 4.1919-1920

Question ID : 7773935404
Status : Answered
Chosen Option: 1
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Q.2 With reference to physical features of India, in which river is the world’s largest riverine
island, Majuli, located?

Ans o 1. Brahmaputra
X 2. Krishna

X 3. Cauvery

X 4. Kosi

c

Question ID : 7773935398
Status : Answered
hosen Option : 1

Q.3 With reference to the rich cultural traditions of India, in which state/union territory is the
Yaoshang Festival celebrated?

Ans 1. Manipur
25 2. Ladakh
25 3. Jammu and Kashmir

X 4. West Bengal

Chosen Option: 2

Question ID : 7773935397
Status : Answered

Q.4 In which city was India’s first uterine transplant baby born in October 2018?
Ans X 1.Chandigarh

X 2. Panaji

" 3. Pune

5 4. Nagpur

Question ID : 7773935405
Status : Answered
Chosen Option: 3

Q.5 With reference to Wildlife Sanctuaries and National parks of India, in which state is the
Mukundra Hills National Park located?

Ans o 1.Rajasthan

X 2.Goa

25 3. Uttar Pradesh
X 4. Punjab

Question ID : 7773935399
Status : Answered
Chosen Option : 3
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Q.6 Who among the following has been awarded the 22nd Lal Bahadur Shastri National Award
for Excellence in October 2021?

Ans X 1.Cyrus S. Poonawalla
< 2. Adar Poonawalla
< 3.Dr. Naresh Trehan
«” 4. Dr. Randeep Guleria

Question ID : 7773935409
Status : Answered
Chosen Option: 1

Q.7 With reference to the rich folk culture of India, what is the traditional bamboo dance of
Mizoram called?

Ans X 1.Hojagiri
25 2. Nongkrem
«# 3. Cheraw
< 4. Dhol-Cholom

Question ID : 7773935395
Status : Answered
Chosen Option: 3

Q.8 In October 2021, World football body, FIFA unveiled the official mascot of the U-17 Women's
World Cup India 2022 representing women power.

Ans X 1.lbha-an Indian leopardess
/< 2. Ibha - a Bengal tigress
" 3. Ibha - an Asiatic lioness
25 4.bha - a female cheetah

Question ID : 7773935408
Status : Answered
Chosen Option : 2

Q.9 Government think tank Niti Aayog and Rocky Mountain Institute (RMI) on September 15,
2021, launched a campaign called 'Shoonya', which is an initiative to promote:

Ans X 1.zero tolerance for environmental degradation
X 2. zero-corruption
" 3. zero-pollution

X 4. zero tolerance for malnutrition

Question ID : 7773935410
Status : Answered
Chosen Option: 1
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Q.10 The Indian Himalayan Region is spread across Indian States/Union Territories
as on January 1, 2021.

Ans X 1.10
& 2.13
X 3.11
X 4.12

Question ID : 7773935400
Status : Answered
Chosen Option: 3

Q.11 With reference to India's independence movement, who among the following led a band of
10 revolutionary activists in the Kakori Train Robbery carried out in 1925?

Ans X 1.Khudiram Bose
" 2. Ramprasad Bismil
25 3. Udham Singh
/< 4. Chandra Shekhar Azad

Question ID : 7773935393
Status : Answered
Chosen Option : 4

Q.12 With reference to Indian Constitution, Part
related to Emergency.

Ans X 1.XV

X 2.XIV
o 3. XVIII

X 41X

of the Constitution specifies provisions

Question ID : 7773935401
Status : Not Answered
Chosen Option : --

Q.13 What was the rank of India in the Henley Passport Index for the year 2021, which lists the
world’s most travel-friendly passports?

Ans X 1.80
X 2.65
% 3.95
o 4.90

Question ID : 7773935407
Status : Answered
Chosen Option : 2
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Q.14 India’s Polar Satellite Launch Vehicle PSLV-C51 successfully launched Amazonia-1 along
with co-passenger satellites on February 28, 2021, from Satish Dhawan Space
Centre SHAR, Sriharikota.

Ans X 1.9
X 2.15
o 3.18
X 4.3

Question ID : 7773935406
Status : Not Answered
Chosen Option : --

Q.15 As of 1st December 2021, the Bank rate in India as fixed by the Reserve Bank of India is:
Ans X 1.575%

X 2.4.75%
< 3.6.25%
o 4.4.25%

Question ID : 7773935403
Status : Answered
Chosen Option : 4

Q.16 With reference to great dynasties which ruled India, which among the following dynasty is
not associated with the Southern part of India?

Ans X 1.Pandyas
" 2. Chahamanas
/< 3. Cholas
25 4. Cheras

Question ID : 7773935392
Status : Answered
Chosen Option : 2

Q.17 Who among the following discovered remains of the Harappan Civilization at Lothal site?
Ans  # 1.S.R Rao

25 2. Hasmukh Dhirajlal Sankhalia
25 3. Bhagwan Lal Indraji
X 4. Dayaram Sahni

Question ID : 7773935391
Status : Answered
Chosen Option: 4
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Q.18 With reference to India's independence movement, who among the following was the first-
ever woman to be elected as the President of the Indian National Congress in 1925?

Ans & 1. Sarojini Naidu
< 2. Kamla Nehru
< 3. Sucheta Kriplani
25 4. Nellie Sengupta

Question ID : 7773935394
Status : Answered
Chosen Option: 1

Q.19 Who among the following Indian classical musicians has/had acquired international fame
by playing the classical instrument, Santoor?

Ans X 1.Ustad Amjad Ali Khan
25 2. Pandit Ravi Shankar
25 3. Ustad Bismillah Khan
¥ 4. Pandit Shivkumar Sharma

Question ID : 7773935396
Status : Answered
Chosen Option : 4

Q.20 Golden Jubilee of Indian Parliament was celebrated on
Ans X 1.15th August 1997

" 2. 13th May 2002
25 3.26th November 2000
25 4.13th March 2018

Question ID : 7773935402
Status : Answered
Chosen Option: 3

Section : Computer Literacy

Q.1 Which of the following is not a free email website?
Ans X 1.Zoho Mail

2. Yahoo Mail
7 3. AOL Mail

«" 4. Google Workspace product

Question ID : 7773935427
Status : Answered
Chosen Option : 4
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Q.2
Ans X 1.A parabola

25 2. An ellipse
25 3. Acircle
«# 4. A diagonal line

Question ID : 7773935417

Chosen Option : --

Status : Not Answered

Q.3 Which of the following is a type of email attack in which the attacks are the practice of
sending fraudulent communications that appear to come from a reputable entity or person
in email or other communication channels?

Ans X 1.Business email compromise
" 2. Phishing
25 3. Spamming

X 4. Ransomware

Question ID : 7773935426

Chosen Option: 2

Status : Answered

Q.4 Which of the following is false with reference to deleting Facebook account?
Ans X 1.1t may take up to 90 days before all stored data is deleted from backup systems.

< 2.If you log after initial facebook delete request, account will not be deleted.
25 3. Once Facebook account is deleted, you cannot get it back.

" 4. Facebook deletes accounts immediately after the initial request.

Chosen Option : 4

Question ID : 7773935430
Status : Answered

Q.5 Find the odd one out in ‘Show' group of View Tab of MS-Word 2019.
Ans o 1. Footer

& 2. Navigation Pane
2 3. Guidelines
25 4. Ruler

Chosen Option : 3

Question ID : 7773935413
Status : Answered
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Q.6 The keyboard shortcut 'Alt+A’ in MS-PowerPoint 2019 is used to
Ans  # 1. Open the Animations tab and add animations to slides.

#< 2. Open the Design tab and apply themes and customize slides.
25 3. Open the Transitions tab and add transitions between slides.

5 4. Open the Draw tab and access the drawing tools.

Question ID : 7773935422
Status : Answered
Chosen Option: 1

Q.7 In MS-Excel 2019, what is the maximum range of font size supported now?
Ans X 1.0to 255

X 2.1t031
X 3.-72t0+72
& 4110409

Question ID : 7773935418
Status : Not Answered
Chosen Option : --

Q.8 In an MS-Excel sheet, a cell with text overflow problem can be dealt with
Ans X 1. Text Merging

5 2. Text Aligning
" 3. Text Wrapping
25 4. Text Bumping

Question ID : 7773935419
Status : Answered
Chosen Option: 3

Q.9 Which of the following cannot be used to delete a part of text in MS-Word 2019?
Ans X 1. Select the text and press Ctrl + X.

< 2. Select the text and press the Backspace or Delete key.
¥ 3. Select the text and press Shift + F3 key.

< 4. Place the cursor next to the text then press Backspace key.

Question ID : 7773935416
Status : Answered
Chosen Option : 3

Q.10 Which of the following is correct way to block a Facebook user?

Ans 1. Goto the Settings — Blocking — Enter the name of the person - Click Block option.
#5 2. Go to the profile of the person - Click on About option to block
25 3. Go to the profile of the person - Click on More and select Block

25 4. Go to the profile of the person - Click on Check-ins to block

Question ID : 7773935429
Status : Answered
Chosen Option : 2

3@ Teachingninja.in



Q.11 Which of the following keyboard shortcut in MS-PowerPoint 2019 is used to open the Slide
Show tab and set up and play the Slide Show?

Ans X 1. Alt+N
X 2. Alt+K
& 3. Alt+S
&4 AL+ G

Question ID : 7773935421
Status : Answered
Chosen Option: 3

Q.12 Completed version of Twitter was debuted in which year?
Ans X 1.2004

& 2.2007
X 3.2005
X 4.2002

Question ID : 7773935432
Status : Answered
Chosen Option : 3

Q.13 Which of the following symbols is used to to make text bold in WhatsApp chat?
Ans X 1.

X 2.

X 3

o 4

Question ID : 7773935434
Status : Answered
Chosen Option: 4

Q.14 Which of the following is a predefined set of colors, fonts and visual effects that you apply
to your slides for a unified, professional look in MS-PowerPoint 2019?

Ans o 1. Themes
2. Transitions
# 3. Templates
25 4. Layouts

Question ID : 7773935424
Status : Answered
Chosen Option: 3
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Q.15

Ans 2 1.0) - b;ii)~d;iii)-a;iv)~c
o 2.0)-aii)-d;ili-bjivoc
X 3.0) —c;ii) —d;iii))-b;iv)~a
X 4.0 -aiiobiil)-divec

Question ID : 7773935415
Status : Answered
Chosen Option : 2

Q.16 In MS-Word 2019 document, email address text string is automatically shown as a
hyperlink. To remove this link which of the following option is selected?

Ans X 1. Remove Underline
2 2. Edit Hyperlink
" 3. Remove Hyperlink

#< 4. Convert to Regular Text

Question ID : 7773935414
Status : Answered
Chosen Option : 3

Q.17 Maximum possible number of rows in MS-Excel 2019 is
Ans X 1.1024

X 2.32768
X 3.65536
o 4.1048576

Question ID : 7773935420
Status : Answered
Chosen Option: 4

Q.18 Which of the following key is used to run spell check in MS-Word 2019?
Ans X 1.F1

X 2.F5
X 3.F3
& 4 F7

Question ID : 7773935411
Status : Answered
Chosen Option : 4

Q.19 Which of the following is false with reference to animations in MS-PowerPoint 2016?
Ans X 1.Entrance and Emphasis are animation effects.

" 2. You cannot animate text and objects such as clip Art, Shapes, and Pictures.
#< 3. To apply Animation you can use Animations tab.

25 4. Transitions and Animations are different.

Question ID : 7773935425
Status : Answered
Chosen Option: 1
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Q.20 Cover photos for Facebook (mobile) dimensions shoud have awidthof _______ and
height of

Ans X 1.1280 px; 720 px
25 2.180 px; 180 px

" 3. 640 px; 360 px
25 4.1200 px ; 628 px

Question ID : 7773935428
Status : Answered
Chosen Option: 1

Q.21 To start a phone call on WhatsApp, you need to do is open
Ans & 1. Chat window

& 2. Settings window
#< 3. Camera window

#< 4. Status window

Question ID : 7773935435
Status : Answered
Chosen Option : 1

Q.22 You can rehearse your presentation to make sure that it fits within a certain time frame.
While you rehearse, use the feature to record the time that you need to present each
slide in MS-PowerPoint 2019?

Ans X 1.Slide Advancement

2 2. Slide Transition
#< 3. Slide Animation
" 4. Slide Timing

Question ID : 7773935423
Status : Answered
Chosen Option : 2

Q.23 Which of the following options is not available in ‘Table of Contents' group of 'REFERENCES'
Tab In MS-Word 2019?

Ans X 1.Add text
«# 2. Cross Reference
25 3. Automatic Table 1
& 4. Update table

Question ID : 7773935412
Status : Answered
Chosen Option : 2
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Q.24 Username in Twitter is also known as
Ans X 1. Twitter name

" 2. Twitter handle
25 3. Twitter app
X 4. Twitter profile

Question ID : 7773935431
Status : Answered
Chosen Option : 2

Q.25 Which of the following is not a microblogging site?
Ans X 1. Twitter

X 2. Tumblr
" 3. WhatsApp
& 4. Instagram

Question ID : 7773935433
Status : Answered
Chosen Option : 3

Section : FSSAl(General understanding)

Q.1 Who has the authority to grant or revoke a food company operator's license?
Ans X 1.Food Safety Officer

«” 2. Designated Officer
#< 3. Commissioner of Food Safety
25 4. Adjudicating Officer

Question ID : 7773935440
Status : Answered
Chosen Option : 2

Q.2 is comprised of all Food Safety Commissioners.
Ans X 1.Food and Nutrition Board

X 2. Scientific Committee
5 3. Scientific Panels

# 4. Central Advisory Committee

Question ID : 7773935438
Status : Answered
Chosen Option : 4
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Q.3 According to FSSAI, full form of UCO.
Ans  # 1. Used Cooking Oil

#< 2. Usable Cooking Oil
25 3. United Corporation Office
5 4. Unstable Cooking Oil

Question ID : 7773935455
Status : Answered
Chosen Option: 1

Q.4 Full form of FICS:
Ans & 1. Food Import Clearance System

< 2. Food Inspection Clearance system
X 3. Facilitating Interface Clearance system

25 4.Food Investigation and Clearance system

Question ID : 7773935443
Status : Answered
Chosen Option : 1

Q.5 The Basic Food Safety Training Programme and Certification for Food Handlers in India
includes:

Ans X 1. Street food vending, Bakery, Catering
25 2. Catering, Edible Oil, Packaged water
«# 3. Street food vending, Catering, Retail and Distribution

< 4. Manufacturing/Processing, Edible oil, Bakery

Question ID : 7773935457
Status : Answered
Chosen Option: 4

Q.6 What is the full form of 'DASH' diet?
Ans X 1.Dietary Approach to Stay Healthy

X 2. Dietary Application to Stop Hyperglycemia
< 3. Dietary Approach to Stop Hypoglycemia
«" 4. Dietary Approach to Stop Hypertension

Question ID : 7773935447
Status : Answered
Chosen Option: 1

Q.7 One potential CSFH in Mumbai is:
Ans X 1.Rishi Nagar

" 2. Zaveri bazar
#< 3. Chaat bazar
25 4. Kamala Nehru Park

Question ID : 7773935454
Status : Not Answered
Chosen Option : --
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Q.8 is the International Standard for Accreditation of Laboratories.
Ans X 1.1S0O 17045

< 2.150 17026
X 3.1S0 17051

o 4.1S0 17025

Chosen Option : --

Question ID : 7773935442
Status : Not Answered

Q.9 The source of vitamin-A in fortified oil is:
Ans X 1.Retinyl iodate

w# 2. Retinyl palmitate
X 3. Retinyl ester
& 4. Retinyl sulphate

Chosen Option : 2

Question ID : 7773935450
Status : Answered

Q.10 of the Food Safety and Standards Act establishes a system and guidelines for
accrediting certification bodies for the Food Safety Management System (FSMS).

Ans  # 1.Sec. 16(2)(c)
75 2.Sec 16 (4)(a)
25 3.Sec 16(4)(c)
X 4.Sec 16(5)(a)

Chosen Option : --

Question ID : 7773935444
Status : Not Answered

Q.11 Which one is not approved by FSSAI as artificial sweetener?
Ans X 1.Neotame

X 2. Aspartame
25 3. Acesulfame potassium

«” 4. Sodium cyclamate

Question ID : 7773935451
Status : Answered
Chosen Option: 3
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Q.12 _______ of the FSS Act allows the FSSAI to set up an unlimited number of scientific panels
for any purpose.

Ans X 1. Section 12(a)
X 2. Section 13(a)
X 3. Section 12
«# 4. Section 13

Question ID : 7773935437
Status : Not Answered
Chosen Option : --

Q.13 The Commissioner of Food Safety appoints
Ans X 1. Members of the Scientific panel

5 2. Food Safety Officer
#< 3. Food Analyst
«” 4. Designated Officers

Question ID : 7773935459
Status : Answered
Chosen Option : 3

Q.14 Since , Vanaspati in India has been fortified with vitamin A.
Ans X 1.1962

% 2.2016

< 3.1995

o 4.1953

Question ID : 7773935449
Status : Not Answered
Chosen Option : --

Q.15 Pulses are generally adulterated with

Ans X 1.Papaya seeds
X 2. Chalk
«# 3. Chakunda beans
& 4. Turmeric

Question ID : 7773935460
Status : Answered
Chosen Option : 3
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Q.16 F3 dad WR v Ht THehRT sifart 78 82
Ans X 1. 39 =

o 2. TIS[g IR gt <t A

75 3. @re Uerst & Ty § gyyon

X 4. 7o fewat B R FSSAl a1e8i HaR

Question ID : 7773935439
Status : Answered
Chosen Option: 3

Q.17 The Food Standards and Safety Bill (2005) became an Act on:
Ans X 1.26th January, 2006

«" 2. 2nd August, 2006
#< 3.2nd October, 2006
#5 4. 15th august, 2006

Question ID : 7773935436
Status : Answered
Chosen Option : 4

Q.18 is an antioxidant
Ans X 1.vitamin-B1

25 2. vitamin-D

# 3. vitamin-E

X 4. Folic acid

Question ID : 7773935452
Status : Answered
Chosen Option : 2

Q.19 The headquarters of BIS is located in:
Ans X 1.Kolkata

X 2. Mumbai
< 3.Bangalore
«” 4. New Delhi

Question ID : 7773935441
Status : Answered
Chosen Option: 4

Q.20 The Food Safety and Standards Act 2006 came into force on
Ans X 1.August 15,2008

# 2. August 5,2008
#< 3. August 15,2011
« 4. August 5,2011

Question ID : 7773935458
Status : Answered
Chosen Option : 4
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Q.21 Which of the following is an auditor's function and responsibility?
Ans X 1. Start an audit according to the industry's risk classification.

¥ 2. Carry out the responsibilities specified in Section 10 of the FSS (FSA) Regulations,
2018.

#< 3. Establish a protocol for audit management

25 4. Ensure that there are no conflicts of interest.

Question ID : 7773935445
Status : Answered
Chosen Option : 1

Q.22 Ethanol can be prepared from:
Ans X 1.onion

«# 2. cassava
< 3.banana
X 4. tapioca

Question ID : 7773935456
Status : Answered
Chosen Option: 4

Q.23 The WHO recommends a sodium consumption of
Ans X 1.7.5gm

25 2.5000 mg
25 3.10gm
«" 4.2000 mg

per day as a safe level.

Question ID : 7773935448
Status : Answered
Chosen Option : 1

Q.24 Ffe e §E g | i fAuer & fog F 7 9 g ar wgt 82
Ans X 1.8 R & %l ok Wi i 2R gwrE g =iRul

X 2. 9IS IR PR T &5 WS SR gegafedd g anfeu|
o 3. AV IUNHIST I ITANT & ged are u=fifad forar s =nfegy
X 4. &e e Rafg ®u  forar s anfgul

Question ID : 7773935453
Status : Answered
Chosen Option : 2
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Q.25

Ans

X 1. Enriched foods
X 2. Plant based foods
2% 3. Fortified foods
" 4. Organic foods

Question ID : 7773935446
Status : Answered
Chosen Option: 1
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